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How to update a program to XP-8x3x-CE6

Summary for updating a program to XP-8X3X-CE6

® The platform development SDK package installed on PC for developing the program for
XP-8x3x-CE6 must be version 1.4.5 or later.

® The PACSDK.dIlI/PACSDK.lib used for XP-8x3x-CE6 must be version 4.4.0.1 or later.

® The VC program must be re-built with PACSDK.lib by Visual Studio.

® The C#/VB program aren’t re-built by Visual Studio.
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Platform Comparison

CPU LX800/Atom | R3600 ‘
Models XP-8x4x/ XP-8x4x-Atom XP-8x3x

OS Version WinCE 6.0 WinCE 6.0
Development Tools VS2005/VS2008 VS2005/VS2008
Embedded SQL Server 35 3.5

.Net Compact Framework 35 3.5

Development Tool Requirements

Ensure that the necessary tools and the corresponding PAC SDKs are installed in your
computer. The table below provides a summary of the supported development tools and

languages required for developing PAC applications.

Language \IE]
Development Tool Basic .Net

‘ Visual C# | Visual C++

Any version except
Visual Studio - -- -

Professional
2005 or earlier

Professional Vv Vv Vv

Any version except

Visual Studio Professional == -- -
2008
Professional \' v ]
Any version except
Visual Studio -- - -

Professional

2012 or later
Professional -- -- --

V: Supported, --: Unsupported

Microsoft‘w
Visual Studio
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Visual Studio 2005/2008 Professional

Visual Studio takes full advantage of the .NET Compact Framework, which uses public
Internet standards to enable integration with new and existing applications running on

any platform. Supported languages include Visual C#, Visual C++ and Visual Basic .NET.

If you have an MSDN subscription, VS2005/VS2008 Pro can be downloaded from

https://msdn.microsoft.com/en-us/subscriptions/securedownloads/hh442898 Otherwise,

you will need to purchase the software from your regular distributor.

Installation Procedure for VS2005

Step 1: Download the necessary installation files and updates

1. Visual Studio 2005 Professional

https://www.dreamspark.com/Product/Product.aspx?productid=1

2. Visual Studio 2005 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

Installation Procedure for VS2008

Step 1: Download the necessary installation files and updates

1. Visual Studio 2008 Professional

https://www.dreamspark.com/Product/Product.aspx?productid=1
2. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986
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Step 2: Install the platform development SDK package

The PACSDK_CE_X.X.X_VS2008 misi file contains the C header files, the C libraries and

the software development kit used to develop applications for the PAC series on the PC.

The SDK package can be found in the
CD:\SDK\PlatformSDK\ folder on the companion CD that was provided with the
package, or the latest version can be downloaded from the ICP DAS web site.

http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/platformsdk/

File name: PACSDK_CE_X.X.X_VS2008.msi, where X.X.X is the released version of the
platform sdk. The platform sdk of version 1.4.5 or later to support XP-8X3X-CE6.

Step 3: Execute the PACSDK_CE_X.X.X_VS2008.msi file (for VS2008) or
PACSDK_CE_X.X.X_VS2005.msi file (for V52005)

Step 4: Follow the prompts until the installation process is complete
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http://ftp.icpdas.com/pub/cd/xp-8x3x-ce6/sdk/platformsdk/

Creating a new project

The Visual C++ project template is a composite control that is used in this example to

create a new project.

Step 1: Start Visual Studio 2008

D

Step 2: On the File menu, point to New, and then click Project to open the New Project

dialog

Edit View Tools Test Window Help

New » | 5] Project. Ctrl+Shift+N
' Open b | ‘@ | Web Site.. Shift+Alt+N

Close '3  File.. Ctrl+N

Close Solution Project From Existing Code...

Save Selected tems  Ctrl+5S
Save Selected Items As...
Save All Ctrl+Shift+5

® &b

Export Template...

L | Page Setup...

3 | Print.. Ctrl+P
Recent Files >
Recent Projects »
Exit

Step 3: In the Project types pane, expand the Visual C++ node and then select Smart

Device

Step 4: In the list of Templates, select the MFC Smart Device Application item
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Step 5: Specify a name and a location for the application, and then click OK

New Project

Progect tvpes: Templates: | HET Framework 3.5 b | |§|
[+ ¥izual Basic Yisnal Studio installed templates
[ Vizual C#
=- V:isu.al C+t @ATL Smart Device Project E']‘HMFC Smart Device Active Control
- ATL S MFC Smart Device Application i MFC Smart Device DLL
.!E‘ Win?2 Smart Device Project
My Templates

i Fearch Online Templates...

. Wini2

i Other Project Twpes
t- Test Projects

[rul

=l

| An application for Windows Mobile and other Windows CE-bazed devices that uses the Microsoft Foundation Class Libray |

HWanme: | SDEInformatinn |

Location: | ChDocuments and Settngs\Windows\by Documents\W_ Windowsd My Documents w | Browse...
Solution; |Create new Solution A4 | Create directory for solution

Solution Name: | SDKInformation |

[ 0K [ Coaneel

Step 6: When the following windows appears, click Next

MFC Smart Device Application Wizard - Read IO

ba Welcome to the MFC Smart Device Application
B Wizard
Overview These are the current project settings:
Platforms 5. Pocket PC 2003 Platform

Appication Type 5. Single document interface

Document Template Strings Click Finish from any window to accept the current settings.
User Interface Features After you create the project, see the project’s readme. txt file for information about
Aidvanced Faamiras the project features and files that are generated.

Generated Classes

E Next> I[ Finish ][ Cancel ]
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Step 7: On the Platforms screen, select the platform to be added to the project,
XPacSDK_CE and then click Next

MFC Smart Device Application Wizard - Read IO

o —

—=mm  Platforms

Overview Select platform SDKs to be added to the current project.
Platforms
Application Type
2 nstalled SDKs: Selected SDKs:
Document Template Strings
Pocket PC 2003 XPacSDK_CE
User Interface Features Smartphone 2003
Advanced Features

Generated Classes

BB R

XPacSDK_CE

Instruction sets: x86

[ < Previous ][ Next > ][ Finish ][ Cancel ]

Step 8: On the Application Type screen, select the Dialog based option, and then click
Next

MFC Smart Device Application Wizard - Read IO

Application Type
Overview Application type: Use of MFC:
Platforms O Single document (O Use MFC in a shared DLL
Application Type (® Dialog based (® Use MFC in a static library
Document Template Strings O Single document with DocList

User Interface Features

Advanced Features Resource language:

Generated Classes

[<Previous ” Next > ][ Finish ][ Cancel ]
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Step 9: Click Next on the User Interface Features screen

MFC Smart Device Application Wizard - SDKInformation

User Interface Features

Overview Command bar:
Menus only

Menus and buttons

Platforms

Application Type

Document Template Strings
User Interface Features v 'd. -
Advanced Features pisiog e
SDKInformation

Generated Classes

[ < Previous ][ Next > ][ Finish ][ Cancel ]

Step 10: Click Next on the Advanced Features screen

MFC Smart Device Application Wizard - Read IO

Advanced Features

Overview Advanced features:

Platforms

Application Type Printin

Document Template Strings [ Activex controls
User Interface Features | Windows sockets
Advanced Features Number of files on recent file fist:
Generated Classes 4

[<Previous ” Next > J[ Finish J[ Cancel ]
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Step 11: Click Finish on the Generated Classed screen

MFC Smart Device Application Wizard - SDKInformation

Generated Classes

Overview Generated classes:

Platforms CSDKInformationApp
CSDKInfoermationDlg

Application Type

Document Template Strings

User Interface Features

Class name:
Advanced Features — .
= |csDKInformationapp | |
Generated Classes

B

Next > [ Finish ][ Cancel ]
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Configuring the Platform

When developing applications using Visual C++, the Platform must be configured to
indicate which platform and device the application will be downloaded to. Before

deploying the project, ensure that the platform is corrected.

On the Debug configuration toolbar, select the Release option and then select
XPacSDK_CE (x86), as illustrated below.

b Releas + XPacEDE_CE (=26) = |l

Last Modified Date: April 2017




Specifying the PAC SDK Libraries

The PACSDK libraries for XP-8000-CE6 series module are provided in the PACSDK, and are
compatible with C++. In order to use a component in an VC application, It is must to link
PACSDK.lib in the project first.

Step 1: On the View menu, click the Property Pages option

File Edit | View | Project Build Debug Tools Test Window Help
=4 | Solution Explorer Ctrl+Alt+L
3 | Bookmark Window Ctrl+K, Ctrl+W
5% | Class View Ctrl+Shift+C
_ & Code Definition Window  Ctrl+Shift+V
| Object Browser Ctrl+Alt+)
=] | Output Alt+2
EE, Property Manager
Resource View Ctrl+Shift+E
%+ | Toolbox Ctrl+Alt+X

Find Results >
Other Windows >
Toolbars »
3l | Full Screen Shift+Alt+Enter
&1| Navigate Backward Ctrl+-
(%) | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages

Step 2: In left pane of the Property Pages dialog, expand the Linker node, and then click
Input
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Step 3: In the right pane of the Property Pages dialog, enter PACSDK.lib in the

Additional Dependencies item

SDKInformation Property Pages

Configurstion: | AetiveDebug) v | Blatform: | Active(PacSDK_CE (:36)) v | Configuration Manager... |
- CDmJ_nl:-n P_roperl:i.es ) Additional Dependencies FACSDE lib E]
= Configuration Properties Ignore All Default Libraries Na

-+ Generel Tgnore Specific Lib
 Dehuzsi znore Bpecific Libranys
.. Deplonmment Module Definition File
- CAC+H Add Module to Asmmbly
= Linker :
 Cleneral Embed Managed Resource File
Taput Force Swmhbol References
Manifest File Dielaor Loaded DLLs
Debugzing Azembly Link Resource
Barstemn
Optimization
Embedded IDL
Advanced
----- Comimand Ling
- Remurres
- KML Document Generator
[+ Browse Information
- Build Events
- Cuztory Build Step
- Authenticode Signing
Additional Dependencies
Specifies additional items to add to the link line {ex: kemel32 1ib); confizguration specific.
[ e || @ | =Fw

Step 4: Click the OK button to exit the Property Pages dialog
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Adding a control to the form

A variety of controls can be dragged from the Toolbox and placed onto the form. These
controls, however, are not really "live"; they are simply images that can be used as a

convenient method of moving an object to a precise location on the form.

After adding a control to the form, use the Properties dialog to set the parameter values
for the control, such as the background color and the default text, etc. The values that are
specified in the Properties dialog are the initial values that will be assigned to that

property when the control is created at run time.

Step 1: On the View menu, click the Resource View option

File Edit | View | Project Build Debug Tools Test Window Help

[Z] | Code Ctrl+Alt+0
=3 | Solution Explorer Ctrl+Alt+L
) | Bookmark Window Ctrl+K, Ctrl+W
4% | Class View Ctrl+Shift+C
_ & Code Definition Window  Ctrl+Shift+V
% | Object Browser Ctrl+Alt+)
=] | Output Alt+2
E Property Manager
'H Resource View Ctrl+Shift+E
%+ | Toolbox Ctrl+Alt+X
Find Results »
Other Windows »
Toolbars b
| | Full Screen Shift+Alt+Enter
&1| Navigate Backward Ctrl+-
& | Navigate Forward Ctrl+Shift+-
Next Task
Previous Task
Property Pages
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Step 2: In the Resource View Panel, expand the [Project name].rc file node, expand the

Dialog node, and then click the plug-in dialog item

=-izd SDK_Info
&-£1 SDK_Info.rc
=-£a Dialog

BR®=-[1DD_SDK_INFO_DIALOG |
e~ Icon \/

@£ Version

SDKnfo.rc - IDD_S... - Dialog| v X
Lllllld
] SDK_Info (2]

]

TODO: Place dialog controls here,

< i | r
Resource... [3¢ Toolbox [ Property . |

Lo

~

Step 3: Drag a Button control from the Toolbox panel onto the form
m
H Dialog Editor -
k Pointer H
||:| Button
x| Check Box H\
ab| Edit Control i \/
B ~SDKUnfo.rc - IDD_S... - Dialog| v X
EB List Box o
™ Group Box N = -
If Radic? Button =1 SDK Info @
An Static Text -
Picture Control - ::
@ Horizontal Scroll Bar : " " "
B Vertical Scroll Bar - 4 TODO: Place dizlog controls here.
4= Slider Control

3uToolbox [ 2 Propi| | -
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Step 4: On the Properties panel, type Check the SDK version in the Caption field

Properties « 1 X
IDC_BUTTONI (Button Control) ICeButtonEc -
RN EIFAl=

E Appearance

Caption Check the SDK version
Client Edge False
Horizontal Alignmer Default
Modal Frame False
Multiline False
Notify False
Static Edge False
Vertical Alignment Default
B Behavior
Default Button False
Disabled False
Owner Draw False
Visible True
E Misc
(Name) IDC_BUTTOM1 (Button C

rou WWW

Step 5: In the Properties window, type Check the SDK version, and press ENTER to set

the Text property

Properties
IDC_BUTTON1 (Button Control) ICeButtonEditor ~

E] Appearance

Crock e SDK version
Client Ed ge False =
Horizontal Alignment Default =
Modal Frame False
Multiline False
Notify False
T “

Caption

Specifies the text displayed by the control.

rRemurce View ’@Solution Explorer l gProperﬁes '
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Adding the event handling for the control

Once the design stage for the application is complete, code can be added to provide the

functionality for the program.

Step 1: Double-click the button on the form

'] SDK Info (=]

| | | |
s Checkthe SDE vesion  |m
[ ] |

TODO: Flace dialog controls here,

!

Step 2: Insert the following code
char sdk_version[32];
TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);
MessageBox(buf,0,MB_OK);

Y Y e N R A

Hwvoid CSDE InfaoDllz::0nBaClickedButtonl()
{

\J

HfTODD: Add wour control notification handler code here
char sdk _wersion[3Z2];

TCHAR buf[32];

pac FetSDEVersiondesdl version);
rac_dnsiTolideString{sdk_version,buf’;
MessageBox (huf ,0 ,MB_0OF;

\u_m'-....uuf \b"’ J v

}
Hhkgumwnu”wJ“gfrﬂFTﬂxxFug”’“““xujfwwxv““nhfvfw“"“\fh“”‘ﬂvv=—f
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Step 3: Insert the following code into the header section

ttinclude “PACSDK.h”
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B/{ SDE_Infollzg.cpp @ twplementation filé}
H y
. n n a
#include "stdafx.h
#Finclude "SDE _Info.h" <;
#Finclode "SDE Infollg.h” 7
#Finclode "PACSDE.L" EE;
BE#i1fdef _DERUG
ﬂ%ﬁw%;m}




